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We on the Office team are excited to be releasing Microsoft® 

Office 2010. We believe weõve raised the bar again and delivered 

the best productivity experience across the PC, phone and 

browser. It is the result of constant, in-depth research and 

analysis of feedback and data that we receive from our half-

billion customers like you around the world. With each version 

we have two primary objectives: 1) Build on the essentials you 

use today and 2) create tools that anticipate your changing 

needs. In that spirit, Office 2010 makes common tasks easier and 

faster, while bringing new tools that we believe will become the 

essentials of your work tomorrow.  

Even the best ideas can get lost in the growing sea of 

information. So, Office 2010 is designed to help you make your 

ideas stand out. Whether your ideas are intended to inspire one 

person or transform an international organization, Office 2010 is 

designed to help those ideas flow and flourish. Use enhanced 

picture and video tools to create a compelling presen tation to 

ace a class or close a deal. Make sense of volumes of information 

using new and enhanced tools to visually display key trends in 

your data, even within a single cell. But itõs not just about more 

and better; itõs about faster and easier. With the enhanced 

Ribbon and new ways to navigate through your work, your ideas 

can keep flowing from start to finish.  
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 The best ideas often result from several minds working together. 

Office 2010 offers new and enhanced ways for you to work on 

ideas with more people and with less hassle. With co-authoring, 

edit the same document at the same time with others. No more 

multiple versions or waiting your turn. And with Microsoft Office 

Communicator integrated throughout  several Office 2010 

applications, you can view the presence of your team members 

and communicate with them in the context of the work at hand 

and the flow of your ideas. 

Sometimes your best ideas come to you when youõre away from 

your computer. Office 2010 is designed to give you the flexibility 

to work when, where, and how you want. With Microsoft Office 

Web Apps, Microsoft Office Mobile 2010, and expanded offline 

capabilities, you can work confidently and seamlessly across 

different devices.1 

Office 2010 is all about helping your ideas flow and flourish, 

across the PC, phone, and browser. We are excited to have you 

experience all the ways it will help you bring your ideas to life. 

                                                 
1
 Web and smartphone access require an appropriate device and some functionality requires an Internet connection. Web functionality uses Office Web Apps, which require a 

supported Internet Explorer® , Firefox, or Safari browser and either SharePoint®  Foundation 2010 or a Windows LiveË ID. Some mobile functionality requires Office Mobile 2010 which 
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Take a glance at how Office 2010 is designed to give you the best productivity experience 

across PC, phone and browser. Then, get a closer look at the new and improved features in 

the sections that follow. 

 

 Create Incredible  Content  that Gets Your Ideas 

Noticed  

Whether youõre working on the pitch of your career, embarking on a team presentation, 

or preserving your family memories, you want the content you create to be 

extraordinary. Office 2010 delivers an exciting range of new and improved features that 

help you make the right impression every time. For example: 

¶ Use new and improved picture editing tools  available across several Office 2010 

programs. Spectacular artistic effects and advanced correction, color and cropping 

tools help you fine -tune all of the images in your Office 2010 documents without th e 

need for additional photo -editing  programs. 

¶ Embed and edit video  right within Microsoft PowerPoint® 2010. You may be 

amazed at how easy it is to trim your video, add fades, formatting effects, and even 

trigger animat ions from key points in your videoñfor the perfect multimedia 

experience every time. 
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¶ Add some flair to your text with new OpenType typography  available in Microsoft Word 2010 and Microsoft Publisher 2010. 

Create the look of professional typesetting in just a few clicks with support for ligatures, stylistic sets, and other typography 

features available in many OpenType fonts. 

¶ Apply impressive text effects ñsuch as gradient fills and reflectionsñdirectly to the text in your Word 2010 documents. Now you 

can be your own graphic artist with effects that are as easy to apply as bold or underline.  

Save Time and Simplify Your Work  

No matter what the task at hand, you want to focus on getting it done. Fortunately, Office 2010 delivers new and improved tools that 

simplify and save you time at every step. 

¶ Get easier access to the right tools, at the right time. Customize the impro ved Ribbon  to make the commands you need more 

accessible. The new Microsoft Office B ackstageË view  replaces the traditional File menu to provide a single point of reference 

for all of your file management ta sks and more, bringing related but separate features together for easy access.  

¶ Save time and improve your results using the new Paste with Live P review  feature, available in many Office 2010 programs. 

Preview options before you paste content between Office 2010 documents or from other applications. Getting it right the first 

time is always easier than doing it over. 

¶ Capture all of your information, thoughts, and ideas  in one centralized, easily searchable resource with Microsoft OneNote® 

2010. Take notes while working in other programs and your notes automatically link back to the source content ñor quickly file 

copies of content from almost any program in your OneNote 2010 notebooks. 

¶ Jump to the right place in your document, easily rearrange headings, and find what you need quickly using a new search results list and 

automatic hit highlighting. The improved Navigation Pane with integra ted Find tools  in Word 2010 makes it easy to find your way. 

¶ Recover files that you closed without saving!  Thatõs right. Microsoft Excel® 2010, Word 2010, and PowerPoint 2010 enable you 

to easily access versions of files you thought you had lost .  
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Get Easy to Use Data Management  and Analysis Tools  

Office 2010 delivers powerful new features to help you manage and sift through your information, and obtain the power you nee d to 

accomplish your tasks quickly. From your personal budget to your work or school projects, Office 2010 makes it easier to get what 

you need done more int uitively, with more flexibility  and visual results. 

¶ Turn complexity into clarity with new visualization a nd analysis tools  in Excel 2010. Easily display a visual summary of your 

analysis near your values with new tiny charts called Sparklines. Or, use a Slicer to dynamically filter data in a PivotTable®  view or 

PivotChart®  view and display only the relevant details. If you need additional power for your analysis, PowerPivot for Excel 2010, a 

free add-in, was designed for you. Experience lightning-fast manipulations of enormous quantities of data.   

¶ Forget the learning curve. New templates and reusable components make Microsoft Access® 2010 a fast and simple 

database solution . New features such as Application Parts and Quick Start fields enable you to build your database in no time. 

Select from common Access components and add groups of frequently used fields in just a few clicks. And, you can now simplify 

database navigation by easily creating Navigation Formsñno code required.  

¶ Make forms that function. Save your organization time and money, while collecting better infor mation, faster. Microsoft 

InfoPath® 2010 Forms Designer  streamlines business processes with easy-to-makeñand easy-to-useñelectronic forms. Reduce 

redundant data entry and raise the quality of the information you colle ct. 

¶ Work with massive datasets in Excelñmore than 2 gigabytesñand maximize new and existing hardware investments by using the 

64-bit  version of Office 2010.2 

                                                 
2
 This option can only be installed on 64-bit systems. For installation instructions and more information visit: http://office.com /office64setup . 

http://office.com/office64setup
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 Redefine Working Together  

Communication and sharing are essential elements for any collaborative project. And 

when it comes to working with others, you want to focus on the task as opposed to the 

processes. Office 2010 provides new and enhanced features to help you work better 

together and more efficiently share your work with others. Theyõre simple and hassle-free 

so you can get your work done with less effort and better results. 

¶ Office 2010 gives you the power to get things done more quickly and easily with new 

co-authoring capabilities . Edit the same Word 2010 document or PowerPoint 2010 

presentation simultaneously with people in different  locations. Compare ideas and 

information in the same OneNote 2010 shared notebook  with others who are using 

OneNote on their desktop or in a browser. Or, use Microsoft Excel Web App to 

improve your teamwork by editing the same workbook at the same time. 3 

¶ Share your PowerPoint 2010 presentations live  with a remote audience, whether or 

not they have PowerPoint installed. Use the new Broadcast Slide Show feature to 

broadcast your presentation online as you deliver it. And, for those who canõt attend 

the event, create a high-quality video of your presentation with just a few clicks. 4 

¶ Stay on top of your daily communications and quickly take action on e -mail with 

ease in Microsoft Outlook® 2010. The improve d Conversation View enables you to 

easily manage large amounts of e-mail. New Quick Steps perform multi -command 

tasks, such as moving an e-mail to another folder and replying to it with a meeting 

request, in a single click.  

 

                                                 
3
 Co-authoring capabilities require either Microsoft SharePoint Foundation 2010 or a free Windows Live ID. Co-authoring for Word 2010, PowerPoint 2010, and OneNote 2010 via 

Windows Live SkyDrive will become available in the second half of calendar year 2010. 

4
 Broadcast Slide Show requires either SharePoint Foundation 2010 or a free Windows Live ID. To broadcast via SharePoint 2010, Office Web Apps must be installed. 
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¶ Get additional information about people, such as mutual friends and other social information, while staying better connecte d to 

your social and business circles through the Outlook Social Connector . 

¶ Your favorite instant messaging application has an improved, expanded reach. See presence informat ion and a new contact 

card  for your friends and colleagues and easily initiate  a conversation directly from within select Office 2010 applications. And, if 

you use Office Communicator, you get additional tools, such as the ability to initiate voice calls without ever leaving your work.5 

¶ Save time and simplify working with others by using new features  for helping to secure , manage , and share your documents . 

Documents that originate from an Internet source now automatica lly open in Protected View. The Trusted Documents feature 

saves you steps when working with files you already know. And, the Accessibility Checker inspects your file for content that may 

be difficult for people with disabilities to read.  

¶ Work and communicate more easily across multiple languages. Use the improved language tools  in several Office 2010 

programs to specify separate editing, display, Help, and ScreenTip languages. 

¶ Use Microsoft Outlook 2010 with Business Contact Manager  to keep track of the people and organizations with which you do 

business. Create and customize records that reflect your businessñmechanics, vendors, customers, etc. Track leads and 

opportunities  from inception to successful close. Watch your businessõs revenue, gross margin and other metrics in the 

dashboard. Seamlessly share business data with colleagues. Create and follow marketing campaigns and execute projects. And do 

all of this within Outlo ok, the application youõre already familiar with for managing e -mail and calendaring. 

 

                                                 
5
 Instant messaging and presence information require one of the following:  Microsoft Office Communications Server 2007 R2 with Microsoft Office Communicator 2007 R2, Windows 

Live Messenger, or another instant messaging application that supports IMessenger. Voice calls require Office Communications Server 2007 R2 with Office Communicator 2007 R2 or 

an instant messaging application that supports IMessengerAdvanced. 
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 Work, Share, and Communicate Whenever and 

Wherever You Choose  

If your ideas, deadlines, and emergencies donõt always occur at convenient times, you no 

longer have to wait. Office 2010 gives you the freedom and power to get things done 

when and where you need to, from the Web or even from your smartphone. 6 

¶ When you are away from your home or office and away from your own computer, 

you can still make a quick change before that big presentation, have an impromptu 

brainstorming session with your team, or help your best friend with their resume. 

Using Office Web Apps , you can save files online and then access, edit, and share 

them from v irtually any computer with an Internet connection. 7  

¶ Microsoft Office Mobile 2010  brings the powerful Microsoft Office 2010 tools you 

use every day at work, home, or school to your Windows® phone  with an interface 

specifically suited to your mobile deviceõs screen.8 

¶ Microsoft SharePoint® Workspace 2010 expands the boundaries of working with files 

and collaborating with others by enabling you to continue working even when you 

are offline. With offline access to Microsoft SharePoint Server 2010 content , easily 

update documents and lists and be confident that everything will automatically 

synchronize to the server when youõre back online. 

                                                 
6
 Web and smartphone access require an appropriate device and some functionality requires an Internet connection. Web functionality uses Office Web Apps, which require a 

supported Internet Explorer, Firefox, or Safari browser and either SharePoint Foundation 2010 or a Windows Live ID. Some mobile functionality requires Office Mobile 2010 which is not 

included in Office 2010 applications, suites, or Office Web Apps. There are some differences between the features of the Office Web Apps, Office Mobile 2010 and the Office 2010 

applications. 

7
 Office Web Apps include Microsoft Word Web App, Microsoft Excel Web App, Microsoft PowerPoint Web App, and Microsoft OneNote Web App. 

8
 Office Mobile 2010 includes Word Mobile 2010, Excel Mobile 2010, PowerPoint Mobile 2010, OneNote Mobile 2010, and SharePoint Workspace Mobile 2010. Outlook Mobile 2010 

comes pre-installed on Windows phones (Windows Mobile® 6.5 or later) and will be the default e-mail client at the general availability of Microsoft Office 2010.  
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Explore new ways Office 2010 can help you get things done, whether youõre working on 

your own, together, or on the go.  

 

 

 

Microsoft Access®  2010 

Microsoft Excel®  2010 

Microsoft InfoPath ®  2010 

Microsoft Office Communicator 2007 R2 

Microsoft OneNote ®  2010 

Microsoft Outlook ®  2010 

Microsoft PowerPoint®  2010 

Microsoft Publisher 2010 

Microsoft SharePoint®  Workspace 2010 

Microsoft Word 2010  
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Save time and money when you edit the pictures in your Office 2010 documents like a pro, 

without the need for additional photo -editing  programs. 

Youõre putting together an important business report, 

history term paper, or community newsletter ñregardless, 

you want your message to be memorable and look its 

absolute best.  

Fortunately, Office 2010 makes you look like a design 

expert with a range of new and improved tools  for 

working with images. Apply artistic effectsñsuch as paint 

strokes, glass, or watercolor spongeñwith just a couple of 

clicks; use professional-quality correction and color tools 

to fine-tune your pictures in no time; and use advanced 

cropping and a new background removal tool so that you 

always display exactly what you want your audience to 

see. 

 

Available in:       

¶ Use Live Preview to save time when editing photos. The Picture 

Tools Format tab appears whenever you select a picture. Point 

to an option in a  gallery on that tabñsuch as Corrections, 

Color, or Artistic Effects in Word, Excel, PowerPoint, or 

Outlookñto preview the selected formatting applied to your 

picture.  

¶ New and improved picture editing features in Publisher 2010 

differ from those in Word, Excel, PowerPoint and Outlook. See 

the Product-Specific Highlights table on page 15 for details. 
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An advanced 

cropping tool 

displays your full 

image in shadow 

while you crop. 

The crop to 

shape feature 

shown here is 

available in Word, 

Excel, PowerPoint, 

and Outlook. 
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Product-Specific Highlights 

 

¶ All new artistic effects, such as marker, line drawing, blur, 

glass and pastels help you look like a design expert. 

¶ New correction tools, including sharpen, soften, and 

improved brightness and contrast help you perfect pictures in 

no time. 

¶ New color tools, including color saturation and color tone, 

and an improved recolor tool, give you more flexibility for 

coordinating the images in your documents.  

¶ An improved cropping tool enables you to crop to a shape or 

to a selected aspect ratio, or to pan and zoom in on key 

image elements just by dragging and resizing the picture 

within the crop area. 

¶ A new remove background tool makes customizing image 

content a breeze. 

 

¶ Improved photo -editing  tools enable you to crop, pan, and 

zoom in on your images to always show your pictureõs best 

side. 

¶ Improved picture placeholders make it easy to swap out 

pictures while preserving the look and layout of your 

document.  

¶ New picture captions allow you to choose from a gallery of 

layouts such as placing the caption at the top, bottom, or 

sides of your photos, or overlaying text. 

¶ A new picture swap tool enables you to swap the position of 

two selected images on a page, or swap the formatting of 

those images, with just a click. 
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Deliver dynamic presentations that captivate your audience. 

Embed and customize your video experience right in PowerPoint 

2010, without the need for additional software. You can also 

easily insert linked videos that youõve uploaded to Web sites for 

playback directly within your presentation.9  

Make your media fit your message perfectly every time. Edit and 

manage videos you insert from your files  with ease: 

¶ Embed videos . Videos that you insert from your files are now 

embedded by default so you donõt have to manage 

additional files when sharing your presentation with others. 

¶ Video bookmarks . Bookmark key points in your video for 

quick access or trigger animations to start automatically when 

a bookmark is reached during playback. 

 

Available in:  

¶ To insert a video from your files, on the Insert tab, click 

Video and then click Video from File. The Video Tools 

Format and Playback tabs appear automatically 

whenever a video is selected. 

¶ To insert your video from a Web site, on the Insert tab, 

click Video and then click Video from Web Site.  

¶ You can now also trim, add bookmarks, and add fades 

to audio that you insert in your presentation  from your 

files. 

 

¶ Video trim . Trim your video with a simple click and drag, so that your audience sees and hears exactly what you want. 

                                                 
9
 Internet connection required for playback of linked video from a Web site location.  
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Trim video directly 

from within 

PowerPoint 2010. 

¶ Video tools . Add fades, video effects and styles. The formatting and effects that you apply to the videos you insert from your files 

are retained while the video plays. 

¶ Video p oster frame . Use your slide area to tell your story more effectively and avoid solid black rectangles that are difficult to 

print. Select a frame from the video or a picture from your files as an image that fills the object area when the video is not playing. 

¶ Play video as background . Videos inserted from your files remain in the order you place them on a slide, slide layout or slide 

master, enabling you to playback video as a dynamic slide background or as part of a choreographed animation sequence during 

your presentation. 
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¶ Optimize media compatibility . When you need to share a presentation that contains embedded audio or video, or show it from 

another computer, use the Optimize Media Compatibility tool to help ensure the best possible experience.  

¶ Compress media . Simplify sharing with reduced file sizes and improve playback performance by compressing the embedded 

media files in your presentation. 

¶ More format flexibility . Insert a core set of audio and video formats, such as WMV, WMA, and MP3. Core formats supported 

out-of-box will vary with operating system. PowerPoint 2010 also supports additional formats, such as DivX, MOV, and H. 264 

when you install DirectShow codecs available from third parties (fees may apply). 

 

Use new controls to 

pause, rewind, fast-

forward, jump to 

bookmarks and stop 

audio and video 

content whi le 

presenting, without 

leaving slide show 

mode.10 

                                                 
10

 The new audio and video controls are available to media that you insert from your files. Videos that you insert from a Web site will have the controls as provided by that Web site. 
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Add your own flourish to documents and publications by getting the most out of OpenType 

fonts. 

Word 2010 and Publisher 2010 make it easy to add impact to your 

text when you take advantage of the typography capabilities in many 

OpenType fonts. From your company letterhead to personal 

invitations, features including ligatures, stylistic sets, and more provide 

simple but effective ways to add sophistication to your documents 

and publications.  

¶ Explore the OpenType typography features available in both built-

in fonts and custom OpenType fonts that you own. For example, 

try the ligatures in Constantia or number forms and spacing in 

Calibri or Cambria. Or try Gabriola, a new font in Office 2010 that 

offers a rich array of stylistic sets. 

 

Available in:   

¶ In Word 2010, on the Home tab, in the Font group, click 

the dialog launch icon. In the Font dialog box, click the 

Advanced tab. 

¶ In Publisher 2010, select text within any text box. Then, 

on the Text Box Tools Format tab, explore the options 

in the Typography group.  

¶ Available features vary by font. 
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Add elegance to 

your documents 

and publications 

using stylistic sets. 

Product-Specific Highlights 

  

¶ New OpenType typography features include: 

¶ Stylistic sets 

¶ Number forms and number spacing 

¶ Ligatures 

¶ OpenType kerning 

¶ New OpenType typography features include: 

¶ Stylistic sets 

¶ Stylistic alternates 

¶ Number styles (number forms & number spacing) 

¶ True small caps 

¶ Ligatures 

¶ OpenType kerning 
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Add extraordinary effects to your text as easily as applying bold or underline. 

You might increase font size or change font color to draw 

attention to important text. But now, with Word 2010, you can 

take your text to new heights by using the same types of 

formatting effects that you use for graphics and images. 

¶ Unlike WordArt from earlier versions of Word, you apply text 

effects to actual document text, so you can still edit and spell 

check that text and even add text effects to paragraph, 

character, list, or table styles. 

¶ Available text effects include gradient fills, custom shadows, 

reflection, glow, soft edges, bevels and more, as well as a 

range of preset gallery options that enable you to quickly 

apply a coordinated set of effects. 

 

New in:  

Also available in:    

¶ For additional effects that you donõt see in the Text 

Effects gallery, click the dialog launch icon in the Font 

group. Then, at the bottom of the Font d ialog box, click 

Text Effects. 

¶ These same text effects are also available as WordArt 

that can be applied to any text in PowerPoint 2010 and 

to text in graphics in Excel 2010. 

¶ In addition to text, apply similar effects to shapes in 

Word 2010, just as you can in PowerPoint and Excel. 
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The Text Effects 

gallery in Word 

2010 is available 

on the Home tab, 

in the Font group. 
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Locate the commands you need when and where you want them. 

The improved Ribbon, available across Office 2010 applications, 

makes it easy to uncover more commands so you can focus on 

the end product rather than how to get there.  

¶ Customize or create your own tabs on the Ribbon to 

personalize the Office 2010 experience to your work style.  

¶ The standard tabs that you see on the Ribbon are organized 

to display commands relevant to a given task, so that you can 

find what you need more quickly.  

 

New in:     

Improved in:       

¶ To customize the Ribbon, click the File tab to open 

Backstage view. Click Options and then click Customize 

Ribbon. 

 

¶ The Ribbon also provides contextual tabs to give you the right tools at exactly the right time. For example, when you select a 

picture in Word, a contextual tab appears on the Ribbon to provide all the tools you need for editing and formatting that picture.  

 

 

 

 

The customizable Ribbon is new to OneNote, Publisher, InfoPath, and SharePoint Workspace. 
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All the tasks you need are right at your fingertips for enhanced prod uctivity. 

In the upper left corner, next to the Home tab on the Ribbon, you 

see the File tab. Just click the tab for an all-access pass that makes 

it easier than ever to manage your files and customize your Office 

2010 experience. The Ribbon, Mini Toolbar and Live Preview all 

help you work in  your documents; Backstage view helps you work 

with  your documents.  

¶ Get easy, organized access to tools that were previously spread 

across several locations. For example, in several applications, 

print options  (including Print Preview) are now combined on 

 

Available  in:             

¶ In Backstage view, click Options to access your 

application settings.  

¶ Find online resources, such as product updates and 

self-support links, on the Help tab in Backstage view.  

 

one effortless Print tab. Find commonly accessed commands when opening or finishing a document, such as creating, opening, 

and saving files; defining  document properties; and sharing your content.  

¶ Backstage view is extensible. For businesses, IT can incorporate work and information flows from other systems and highlight 

them right within  the most useful Microsoft Office application. For example, Backstage view lets you bring those back-end 

accounting or HR workflows right into Office 2010.  

Backstage viewñboth simple and powerful to use.  
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The integrated Print experience is available in Backstage view for many Office 2010 programs. 
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Product-Specific Highlights 

  

¶ Recover unsaved versions of your documents, check for 

accessibility, or make sure your document is finalized and 

ready for prime time. 

¶ Save documents to a Microsoft SharePoint® 2010 site or 

Windows LiveË SkyDriveË folder so that you and others can 

open and edit them simultaneously.  

¶ View the availability of the document author or other edit ors 

in the Properties pane and instantly communicate with them . 

¶ Recover an unsaved version of your workbook, check for 

accessibility, or make sure itõs finalized and ready for prime 

time. 

¶ Save documents to a SharePoint 2010 site or Windows Live 

SkyDrive folder so that you can share them with others.  

¶ View the availability of the workbook author or other editors  

in the Properties pane and instantly communicate with them.  
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¶ Manage your media with ease using tools to compress and 

optimiz e the embedded video and audio files in your 

presentation. 

¶ Broadcast your slide show live to a remote audience or create 

a high-quality video of your presentation. 11 

¶ Recover an unsaved version of your presentation, check for 

accessibility, or make sure your presentation is finalized and 

ready for prime time. 

¶ Save documents to a SharePoint 2010 site or Windows Live 

SkyDrive folder so that you and others can open and edit 

them simultaneously.  

¶ View the availability of the presentation author or other 

editors in the Properties pane and instantly communicate 

with them.   

¶ Manage your account settings, such as add a new e-mail 

account.  

¶ Configure automatic replies for when you are out of the 

office, modify your archive options, and organize your rules 

and alerts. 

¶ Open an Outlook calendar or data file, import or export your 

files, settings, and RSS feeds, or open a shared folder.  

¶ If your mailbox has a size limit , a new quota thermometer 

provides a visual representation of how much space is left in 

your mailbox. 

 

¶ Share your work to SharePoint Server. 

 

                                                 
11

 Broadcast Slide Show requires either SharePoint Foundation 2010 or a free Windows Live ID. To broadcast via SharePoint 2010, Office Web Apps must be installed. 
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¶ Get started quickly with new built -in and community -

submitted templates  that are hosted online and can be 

accessed through Access. 

¶ Publish your database to SharePoint Server 2010 via newly 

added Access Services to make it available through a Web 

browser.12 

¶ Find essential database management tools, such as compact 

and repair or encrypt your database with a password.  

¶ Easily save a copy of your database in another file format and 

share it with others. Use the new database template format 

for efficient reuse or make a back-up copy of your database 

in just a few clicks. 

¶ Save database objects in PDF or XPS format to share them 

with those who donõt have access to your database. 

¶ Get started quickly with new built -in and community -

submitted t emplates that are hosted online and can be 

accessed through Publisher. 

¶ Use the integrated print experience to adjust print settings 

while viewing a large print preview of your publication with 

rulers and page numbers. Or, use the new backlight feature 

to see òthroughó the paper to preview the other side of your 

two-sided publication and ensure that it prints the way you 

want it to appear. 

¶ Save a PDF or XPS format version of your publication, or save 

a copy of your publication in your choice of several image 

formats, such as JPEG, for easy printing and sharing. 

¶ Save your business information to automatically include it in 

publications, check your publication for design errors, or 

manage commercial print settings. 

                                                 
12

 This feature requires Microsoft SharePoint Server 2010 and Access Services must be enabled.  To access a Web database via a Web browser, an appropriate device, Internet connection 

and supported Windows Internet Explorer 7 for Windows, Safari 4 or later for Mac, and Firefox 3.5 or later for Windows, Mac, or Linux browser are required.  
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¶ View and manage settings for all of your open notebooks and 

sync shared notebooks. 

¶ Create and access shared notebooks, including those stored 

on the Web, so that you can edit your notebook 

simultaneously with others using OneNote 2010 and 

Microsoft OneNote Web App. 13 

¶ Change online connection settings, set alerts for workspace 

changes, manage your account settings, or view and manage 

your message history and contacts. 

¶ Create new workspaces, make your account accessible from 

another computer, or share files on your PC and invite others 

to your  workspaces. 

                                                 
13

 Saving and accessing shared notebooks from the Web, as well as using OneNote Web App, requires SharePoint Foundation 2010 or a free Windows Live ID. On Windows Live, 

OneNote Web App and the ability to simultaneously edit shared notebooks will become available in the second half of calendar year 2010. 



 

Page 30 of 188  

Save time when reusing content across applications.  

The content that you copy between documents and programs 

comes from a variety of sourcesñtables from Web pages, charts 

and graphics from documents, presentations, or workbooks, or 

other content from your notes or e -mail messages. Regardless of 

where your information originates, pasting in Office 2010 has 

never been easier. Preview various Paste Options using Paste with 

Live Preview and determine how your pasted content will look 

before actually pasting. No more using Undo and trying again, 

Paste with Live Preview helps you get it right the first time.  

¶ Ensure that the content you reuse appears exactly as 

intended, resulting in consistent, professional-looking 

documents. 

¶ Available Paste Options change contextually to best fit the 

content you are reusing. 

 

Available in:        

¶ On the Home tab, in the Clipboard group, click the 

arrow beneath the Paste button to view Paste Options. 

Then, hover your mouse pointer on Paste Options to 

preview results before pasting. 

¶ ScreenTips provide additional information to help you 

make a decision. 

¶ The Paste Options gallery can be accessed after 

pasting. Click the icon that appears when you paste to 

expand Paste Options. Or, if you prefer to use the 

keyboard, press CTRL to expand Paste Options and 

then use the left and right arrow keys to move through 

the options. 
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Preview formatting before committing. For example, the options shown here enable you to preview 

how a table will appear in your document before you paste. 
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Create one central resource for all of your thoughts and ideas. 

You may already use OneNote to capture text, images, audio, and video. Now, OneNote 2010 introduces a host of new and improved 

features that help you keep all of your important information more readily accessible than ever before. Following are examples of 

how OneNote 2010 keeps you in control of your content.  

Search Navigation  

The improved search experience in OneNote 2010 shows you search results as you typeñand a new ranking system learns from past 

choices, prioritizing notes, pages, page titles, and recent picks so you can get to exactly what you need faster and easier. 

 

OneNote 2010 search 

filters through 

multiple types of 

content and shows 

you search results as 

you type. 



 

Page 33 of 188  

 

Linked Notes  

Dock OneNote 2010 on the side of your desktop and take notes 

while you work in Word 2010, PowerPoint 2010 or Windows®  

Internet Explorer®. OneNote automatically provides links to 

where you were in the source document at the time you took the 

note. 

Quick Filing  

Itõs easy to collect information while working in other programs. 

Place copies of the content you need from documents, Web 

pages, e-mail messages, or most any program in the exact 

location you want in your OneNote notebooks with just a few 

clicks. 

 

Available in:       

¶ To start taking linked notes in OneNote 2010, in Word 

2010 or PowerPoint 2010, on the Review tab, click 

Linked Notes. In Internet Explorer 6 or later, on the 

Tools menu, click OneNote Linked Notes. 

¶ To use quick filing, take a screen clipping from 

OneNote 2010, send an Outlook 2010 e-mail message 

to OneNote, start a linked note -taking session, or prin t 

a document to the Send to OneNote 2010 virtual 

printer . A dialog box automatically prompts you to 

select the location in your notebooks where you want 

to place the content.  
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Stay on top of your document content ñmore easily than ever. 

Long documents come in many formsñfrom annual reports to 

legal briefs, term papers, and personal manuscripts. But, all of 

these documents have one important thing in common: you 

need quick and easy ways to access and manage your content. 

Fortunately, the improved Navigation Pane in Word 2010 

(formerly called the Document Map) integrates enhanced Find 

tools and seamlessly transforms the experience of navigating and 

organizing your document.  

¶ Browse headings to quickly find the place you need within a 

document and then click to instantly move to that location . 

 

Available in:         

¶ Using the search tools in the centralized Navigation 

Pane, you can also browse the document by object 

typeñincluding g raphics, tables, equations, footnotes, 

endnotes, and comments. Or, access the familiar Find 

dialog box for more advanced searches or Find and 

Replace tasks. Click the arrow in the Search box for all 

of these options and more. 
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Drag and drop headings in the improved Navigation Pane to quickly rearrange document content.  
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¶ Get a quick preview of all search matches in the new results view of the Navigation Pane. Click any result preview to jump to that 

point in the document.  

¶ See automatic highlighting of all search hits in the document. Headings are also highlighted in the Navigation Pane wherever 

search results occur. 

 

The improved Find tools, 

integrated into the 

Navigation pane, include 

the new search results 

pane. 














































































































































































































































































































